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¿QUÉ ES UN SERVICIO WEB?
Un Servicio Web es una tecnología que utiliza un conjunto de protocolos y estándares que sirven para intercambiar datos entre aplicaciones. Distintas aplicaciones de software desarrolladas en lenguajes de programación diferentes, y ejecutadas sobre cualquier plataforma, pueden utilizar los servicios web para intercambiar datos en redes de ordenadores como Internet. La interoperabilidad se consigue mediante la adopción de estándares abiertos.
HISTORIA
Los Servicios Web surgieron ante una necesidad de estandarizar la comunicación entre distintas plataformas (PC, Mainframe, Mac, etc.) y lenguajes de programación (PHP, C, Java, etc.). Anteriormente se habían realizado intentos de crear estándares pero fracasaron o no tuvieron el suficiente éxito, algunos de ellos son DCOM y CORBA, por ser dependientes de la implementación del vendedor DCOM – Microsoft, y CORBA – ORB (a pesar que CORBA de múltiples vendedores pueden operar entre sí, hay ciertas limitaciones para aplicaciones de niveles más altos en los cuales se necesite seguridad o administración de transacciones).
Otro gran problema es que se hacía uso de RPC (Remote Procedure Call) para realizar la comunicación entre diferentes nodos. Esto, además de presentar ciertos problemas de seguridad, tiene la desventaja de que su implementación en un ambiente como es Internet, es casi imposible (muchos Firewalls bloquean este tipo de mensajes, lo que hace prácticamente imposible a dos computadoras conectadas por Internet comunicarse). Los Servicios Web surgieron para finalmente poder lograr la tan esperada comunicación entre diferentes plataformas. En la actualidad muchos sistemas legacy están pasando a ser servicios web. Es por esto que en 1999 se comenzó a plantear un nuevo estándar, el cual terminaría utilizando XML, SOAP, WSDL, y UDDI.
¿QUÉ ES XML, SOAP, WSDL, UDDI?
Son estándares empleados en un servicio web
XML - EXTENSIBLE MARKUP LANGUAGE
Es el formato estándar para los datos que se vayan a intercambiar.
SOAP - Simple Object Access Protocol o XML-RPC (XML Remote PROCEDURE CALL
Protocolos sobre los que se establece el intercambio.
WSDL - WEB SERVICES DESCRIPTION LANGUAGE
Es el lenguaje de la interfaz pública para los servicios Web. Es una descripción basada en XML de los requisitos funcionales necesarios para establecer una comunicación con los servicios Web.
UDDI - UNIVERSAL DISCOVERY DESCRIPTION AND INTEGRATION
UDDI son las siglas del catálogo de negocios de Internet. El registro en el catálogo se hace en XML. 
VENTAJAS DE UN WEB SERVICES
· Aportan interoperabilidad entre aplicaciones de software independientemente de sus propiedades o de las plataformas sobre las que se instalen.
· Los servicios Web fomentan los estándares y protocolos basados en texto, que hacen más fácil acceder a su contenido y entender su funcionamiento.
· Permiten que servicios y software de diferentes compañías ubicadas en diferentes lugares geográficos puedan ser combinados fácilmente para proveer servicios integrados.
DESVENTAJAS DE UN WEB SERVICES
· Para realizar transacciones no pueden compararse en su grado de desarrollo con los estándares abiertos de computación distribuidacomo CORBA (Common Object Request Broker Architecture).
· Su rendimiento es bajo si se compara con otros modelos de computación distribuida, tales como RMI (Remote Method Invocation), CORBA o DCOM (Distributed Component Object Model). Es uno de los inconvenientes derivados de adoptar un formato basado en texto. Y es que entre los objetivos de XML no se encuentra la concisión ni la eficacia de procesamiento.
· Al apoyarse en HTTP, pueden esquivar medidas de seguridad basadas en firewall cuyas reglas tratan de bloquear o auditar la comunicación entre programas a ambos lados de la barrera
¿POR QUÉ CREAR UN WS?
· Para realizar transacciones no pueden compararse en su grado de desarrollo con los estándares abiertos de computación distribuida como CORBA (Common Object Request Broker Architecture).
· Su rendimiento es bajo si se compara con otros modelos de computación distribuida, tales como RMI (Remote Method Invocation), CORBA o DCOM (Distributed Component Object Model). Es uno de los inconvenientes derivados de adoptar un formato basado en texto. Y es que entre los objetivos de XML no se encuentra la concisión ni la eficacia de procesamiento.
· Al apoyarse en HTTP, pueden esquivar medidas de seguridad basadas en firewall cuyas reglas tratan de bloquear o auditar la comunicación entre programas a ambos lados de la barrera.
RAZONES PARA CREAR SERVICIOS WEB
La principal razón para usar servicios Web es que se pueden utilizar con HTTP sobre TCP (Transmission Control Protocol) en el puerto 80. Dado que las organizaciones protegen sus redes mediante firewalls -que filtran y bloquean gran parte del tráfico de Internet-, cierran casi todos los puertos TCP salvo el 80, que es, precisamente, el que usan los navegadores. Los servicios Web utilizan este puerto, por la simple razón de que no resultan bloqueados. Es importante señalar que los servicios web se pueden utilizar sobre cualquier protocolo, sin embargo, TCP es el más común.
Otra razón es que, antes de que existiera SOAP, no había buenas interfaces para acceder a las funcionalidades de otros ordenadores en red. Las que había eran ad hoc y poco conocidas, tales como EDI (Electronic Data Interchange), RPC (Remote Procedure Call), u otras APIs.
Una tercera razón por la que los servicios Web son muy prácticos es que pueden aportar gran independencia entre la aplicación que usa el servicio Web y el propio servicio. De esta forma, los cambios a lo largo del tiempo en uno no deben afectar al otro. Esta flexibilidad será cada vez más importante, dado que la tendencia a construir grandes aplicaciones a partir de componentes distribuidos más pequeños es cada día más utilizada.


JAVA Y LOS SERVICIOS WEB
Integración de Servlets y JSP
Una aplicación Web realiza tareas de procesado y presentación:
· Los Servlets son adecuados para procesado.
· Las páginas JSP son adecuadas presentación.
Una aplicación Web puede combinar Servlets y páginas JSP:
· Procesado de parámetros de la petición: Servlets.
· Acceso a bases de datos: Servlets.
· Lógica de la aplicación: Servlets.
· Presentación (vistas): JSP.
MODELO DE FUNCIONAMIENTO
1. El cliente envía la petición HTTP a un servlet.
2. El servlet procesa la petición.
Si es necesario, se conecta a la base de datos.
3. El servlet redirige la petición a un JSP.
Si es necesario, añade beans como parámetros.
4. El JSP lee los parámetros y devuelve la respuesta formateada visualmente al usuario.
[image: Figura que ilustra lo expuesto en la
 sección anterior (redirección con forward de un servlet a un
 JSP)]
INSTALACIÓN DEL "ECLIPSE IDE FOR JAVA EE DEVELOPERS" 
Y EL SERVIDOR "APACHE TOMCAT"

[image: ][image: http://www.sowre.es/image/image_gallery648f.jpg?uuid=ffef779b-44a7-4e5e-9e6e-2b2e72b9b012&groupId=10421&t=1307023437379]

ECLIPSE IDE FOR JAVA EE DEVELOPERS

Para desarrollar aplicaciones que se ejecuten en un servidor web debemos utilizar la versión de Eclipse que viene con todos los complementos que facilitan el desarrollo.

La versión que debemos descargar es Eclipse IDE for Java EE Developers (http://www.eclipse.org/downloads/packages/release/juno/r), como podemos ver el tamaños es mayor que la versión “Eclipse IDE for Java Developers”

Crearemos la carpeta eclipsej2ee y dentro de la misma descomprimamos el entorno de Eclipse que acabamos de descargar “Eclipse IDE for Java EE Developers”.

[image: ]

Seleccionamos una otra carpeta donde se almacenaran los proyectos que realicemos.

[image: ]

Cuando ejecutamos el Eclipse nos pide seleccionar la carpeta donde se almacenarán los proyectos que crearemos y aparece el siguiente entorno (como podemos ver prácticamente igual que la versión "Java Developers" con un título distinto):

[image: ]
APACHE TOMCAT

El servidor web "Apache Tomcat" nos permitirá ejecutar servlet y páginas dinámicas.

Podemos descargar el "Apache Tomcat" de http://tomcat.apache.org/download-70.cgi (descargar el archivo Binary Distributions Core 32-bit Windows zip) y descomprimirlo en una carpeta.

[image: ]

Una vez descomprimido procedemos a registrarlo en Eclipse. Desde el menú de opciones seleccionamos Window -> Preferences y en el diálogo que aparece debemos seleccionar Server -> Runtimes Environments y presionar el botón "Add...":

[image: ]
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En el nuevo diálogo que aparece seleccionamos de la carpeta "Apache" la versión 7 que es la que acabamos de descargar y descomprimir en una carpeta de nuestro disco duro:
 [image: ]

En el último diálogo que aparece debemos seleccionar la carpeta donde hemos descomprimido el "Apache Tomcat" y presionar el botón "Finish:
 [image: ]

Ahora debemos iniciar los servicios del servidos "Apache Tomcat" para podes hacer aplicaciones que hagan peticiones.
Para arrancar el Tomcat debemos presionar el botón derecho del mouse sobre la ventana "Server", si no parece esta ventana podemos activarla desde el menú (Window -> Show View -> Servers) y seguidamente seleccionar del menú contextual la opción New -> Server:
 [image: ]

En este diálogo seleccionamos "Apache" Tomcat V7.0 y presionamos el botón "Finish":

[image: ]

Como podemos ver ya tenemos el "Tomcat" listo para poderlo utilizar en los distintos proyectos que implementaremos:

[image: ]

Si ingresamos al menú de opciones File -> New veremos que nos permite crear una serie de proyectos muy distintos a la otra versión de Eclipse:
[image: ]


SERVLET
Un servlet es una clase que se ejecuta en el contexto de un servidor web (en nuestro caso el Apache Tomcat).
Un servlet se ejecuta en un servidor web y el resultado de ejecución viaja por internet para ser visualizado en un navegador web (normalmente un servlet genera HTML, pero puede generar otros formatos de archivos).
Cada petición HTTP recibida se procesa en un hilo, e invoca un método del servlet.
VENTAJAS FUNDAMENTALES 
· Portabilidad entre plataformas y servidores.
· Potencia:
APIs de Java
Utilización de código externo.
· Eficiencia: 
Instancia permanententemente cargada en memoria por cada servlet.
Ejecución de peticiones mediante invocación de un método.
Cada petición se ejecuta en un hilo.
Mantiene automáticamente su estado y recursos externos: conexiones a bases de datos, conexiones de red, etc.
· Seguridad:
Lenguaje java: máquina virtual, chequeo de tipos, gestión de memoria, excepciones, etc.
Gestor de seguridad de Java.
· Elegancia:
Código java: modular, orientado a objetos, limpio y simple.
API servlets: potente y fácil de utilizar.
· Integración:
Integración fuerte entre servlets y servidor: permite colaboración entre ambos.
· Extensibilidad y flexibilidad:
API Servlet extensible.
Filtros (cadenas de servlets).
Integrable con JSP (Java Server Pages).
Comunidad grande de desarrolladores.


CONCEPTO DE APLICACIÓN WEB
Conjunto de servlets, JSPs y otros recursos (ficheros HTML, imágenes, ficheros de configuración, etc.) relacionados entre sí por formar parte de la misma aplicación.
Los recursos de una aplicación Web comparten un prefijo de URL.
Una aplicación Web se puede empaquetar en un fichero WAR.
CICLO DE VIDA DE UN SERVLET
· Cuando arranca el servidor:
Se crea una instancia.
Se inicializa el servlet (método init())
· Cuando llega una petición:
Se invoca el método service() sobre un nuevo hilo.
· Cuando se cierra el servidor:
Se invoca el método destroy() y después se destruye el servlet.
SERVLETS HTTP
Heredan de HttpServlet, que implementa el método service() para que invoque a:
· void doGet(HttpServletRequest req, HttpServletResponse resp)
· void doPost(HttpServletRequest req, HttpServletResponse resp)
· void do...(HttpServletRequest req, HttpServletResponse resp)
· getLastModified(HttpServletRequest req)
Los servlets reescriben sólo los métodos doXXX que necesiten.

[image: Figura sobre servlets HTTP descrita en
 el párrafo siguiente]
La figura anterior muestra que para programar un servlet HTTP es suficiente heredar de HTTPServlet y sobreescribir los métodos doGet, doPost, etc. dependiendo de a qué métodos HTTP se desea que responda el servlet. La implementación de service que proporciona HTTPServlet analiza automáticamente el método HTTP de la petición recibida para decidir a qué método del servlet debe invocar (doGet, doPost, etc.)
Ejemplo:
Crear un servlet que nos muestre un mensaje y los números del 1 al 10000.
Desde el menú de opciones seleccionamos File -> New -> Dynamic Web Project:
[image: ]
En el diálogo siguiente especificamos el nombre del proyecto (en nuestro caso le llamaremos HolaMundo) y presionamos el botón "Finish":
[image: ]

El Eclipse nos crea una serie de carpetas y archivos donde alojaremos los servlet:
[image: ]
Ahora presionamos el botón derecho sobre el nombre del proyecto y seleccionamos la opción New -> Servlet:
[image: ]
En el diálogo siguiente especificamos el nombre de nuestro servlet (en nuestro ejemplo le llamaremos HolaMundo), presionamos el botón "Finish" y ya tenemos el esqueleto básico de un servlet:
[image: ]
El código fuente generado es el siguiente:
	import java.io.IOException;
import javax.servlet.ServletException;
import javax.servlet.annotation.WebServlet;
import javax.servlet.http.HttpServlet;
import javax.servlet.http.HttpServletRequest;
import javax.servlet.http.HttpServletResponse;

/**
 * Servlet implementation class HolaMundo
 */
@WebServlet("/HolaMundo")
public class HolaMundo extends HttpServlet {
	private static final long serialVersionUID = 1L;
       
    /**
     * @see HttpServlet#HttpServlet()
     */
    public HolaMundo() {
        super();
        // TODO Auto-generated constructor stub
    }

	/**
	 * @see HttpServlet#doGet(HttpServletRequest request, HttpServletResponse response)
	 */
	protected void doGet(HttpServletRequest request, HttpServletResponse response) throws ServletException, IOException {
		// TODO Auto-generated method stub
	}

	/**
	 * @see HttpServlet#doPost(HttpServletRequest request, HttpServletResponse response)
	 */
	protected void doPost(HttpServletRequest request, HttpServletResponse response) throws ServletException, IOException {
		// TODO Auto-generated method stub
	}

}



Todo servlet debe heredar de la clase HttpServlet que se encuentra en el paquete javax.servlet.http
Esta clase debe sobreescribir el método doGet o doPost (o ambos) En el protocolo HTTP las peticiones pueden ser de tipo post (cuando llamamos a una página desde un formulario HTML) y de tipo get (páginas sin formulario)
Nuestro problema es mostrar un mensaje e imprimir los números del 1 al 10000, esta actividad la haremos en el método doGet.
El algoritmo a implementar en el método doGet para dicha salida es:
	import java.io.IOException;
import java.io.PrintWriter;
import javax.servlet.ServletException;
import javax.servlet.annotation.WebServlet;
import javax.servlet.http.HttpServlet;
import javax.servlet.http.HttpServletRequest;
import javax.servlet.http.HttpServletResponse;

/**
 * Servlet implementation class HolaMundo
 */
@WebServlet("/HolaMundo")
public class HolaMundo extends HttpServlet {
    private static final long serialVersionUID = 1L;
       
    public HolaMundo() {
        super();
        // TODO Auto-generated constructor stub
    }

    protected void doGet(HttpServletRequest request, HttpServletResponse response) throws ServletException, IOException {
        // TODO Auto-generated method stub
         PrintWriter out = response.getWriter();

         out.println("<html>");
         out.println("<head></head>");         
         out.println("<body>");
         out.println("<h1>Hola Mundo</h1>");
         for(int f=1;f<=10000;f++) {
             out.println(f);
             out.println(" - ");
         }
         out.println("</body>");
         out.println("</html>");        
    }

    protected void doPost(HttpServletRequest request, HttpServletResponse response) throws ServletException, IOException {
        // TODO Auto-generated method stub
    }

}


Una parte importante de la declaración del servlet que nos genera automáticamente el Eclipse es la anotación @WebServlet (esta línea registra el servlet para todas las peticiones al servidor con la sintaxis 
http://localhost:8080/nombreProyecto/nombredelServlet):@WebServlet("/HolaMundo")
Obtenemos una referencia de un objeto de la clase PrintWriter (debemos importar la clase PrintWriter) mediante la llamada al método getWriter del objeto response que llega como parámetro al método doGet:
         PrintWriter out = response.getWriter();
Todas las salidas son llamando al método println del objeto out de la clase PrintWriter. Como vemos generamos como salida HTML, para mostrar los números del 1 al 10000 es más conveniente utilizar una estructura repetitiva que hacer una salida secuencial.
Para probar el servlet que acabamos de codificar debemos presionar el botón derecho del mouse sobre el nombre de la clase y seleccionar "Run on Server":
[image: ]
Aparece un diálogo que debemos seleccionar el botón "Finish" ya que está seleccionado el servidor "Tomcat" para ejecutar el servlet:
[image: ]
El resultado de la ejecución del servlet lo podemos ver dentro de una ventana dentro del mismo Eclipse:
[image: ]
Si queremos que el resultado aparezca en otro navegador podemos configurar desde el menú de Eclipse el navegador que muestra el resultado que devuelve Tomcat:
[image: ]
JAVA JSP (JAVA SERVER PAGE)
Java Server Page, es otra de las nuevas tecnologías para tratar de hacer más eficiente el modelo cliente-servidor y sobre todo la construcción de sistemas de comercio electrónico.
En este modelo una pagina HTML también incluye código en java, es el servidor de paginas quien al estar mandando la pagina a la PC remota la compila y la convierte en un servlet.
Esta tecnología combina en una sola aplicación, tanto código HTML como código java.
El proceso de crear un jsp, es sencillo se crea un archivo normal con notepad combinando código HTML y código java, se graba con extensión .jsp, se hace un ftp al servidor y listo.
Cuando el usuario requiere un jsp el servidor lo carga, lo compila, lo convierte a servlet y manda la pagina resultante al usuario remoto.
Características
· Código separado de la lógica del programa.
· Las páginas son compiladas en la primera petición.
· Permite separar la parte dinámica de la estática en las páginas web.
· El código JSP puede ser incrustado en código HTML.
Ventajas
· Ejecución rápida.
· Crear páginas del lado del servidor.
· Multiplataforma.
· Código bien estructurado.
· Integridad con los módulos de Java.
· La parte dinámica está escrita en Java.
Notas:
1.- Para insertar código java dentro de una pagina HTML se deberán usar una serie de tags o delimitadores (en el ejemplo se está usando <% una serie de instrucciones de java %>) donde cada uno de ellos tiene un propósito definido.
Otros delimitadores son:

Comentarios <%– comentario –%> 
Ignorados cuando jsp es convertida a servlet y muy útiles para documentar nuestros programas jsp.
Declaración <%! Variables, métodos, etc. %> 
Recordar que todo buen programa, empieza declarando variables.
Instrucción <%= instrucción %> 
Para poner una y solo una instrucción de java, además recordar que ya existen aparte ciertas instrucciones o variables predefinidas tales como request, response, out, session, application, config, and pageContext( tambien disponibles en scriptlets).
Recordar además que cuando se use <%= una sola instrucción %>, la instrucción no debe terminar con punto y coma.
Scriptlet <% todo un programa completo %> 
Un scriptlet es un grupo de instrucciones de java, como se deduce de esta definición, se usara muchos scriptlets en nuestros jsp.
Aquí si, las instrucciones deben terminar con punto y coma
Un bloque de instrucciones <% bloque java %>, puede empezar (<%) en un scriptlet y terminar en otro scriptlet, pero asegurarse de que todos los scriptlets se abran y se cierren.
Include Directive <%@ include file=“url” %> 
Se usa para incluir archivos en la PC que compila la jsp, esto se realiza al tiempo que la jsp es convertida en servlet, el url debe ser relativo.
Para este caso también es válido:
jsp:include action
Para incluir el archivo al tiempo de request por parte de un usuario remoto
jsp:forward Action <jsp:forward page=“URL relativo”/> 
Manda llamar o enlazar otra página.
¿POR QUÉ JSP?
Los Servlets Java son más eficientes, fáciles de usar, más portables, y más baratos que el CGI tradicional y otras muchas tecnologías del tipo CGI.
[image: ]
Como se ve en la figura anterior, en general, el esquema de funcionamiento de una aplicación bajo Servlets y JSP es muy sencilla. Los usuarios de la aplicación se comunican con ésta mediante objetos “request" y “response”. Las variables que se guardan en éstos objetos tienen poco tiempo de vida (lo que se tarda en mostrar la información al usuario mediante JSP). Si se quieren guardar variables para el control de los usuarios que entran en el sistema, se utilizarán objetos “session” para guardarlas. Estos objetos “session” permanecen activos con los datos hasta que el usuario cierra la sesión o directamente se cierra el navegador. Los JSP no son más que HTML en el cual se puede insertar fragmentos de código Java.
NOTA:
Para utilizar JDBC en un archivo JSP, se necesita el driver de conexión con la BD (en nuestro caso MYSQL, "mysql-connector-java-5.1.18-bin.jar"). Este jar o librería debe estar alguna ubicación del classpath que use Tomcat para tu proyecto.
Para ello, lo colocamos dentro de la carpeta "WEB-INF/lib" del proyecto que lo requiera, o en la carpeta "common/lib" dentro de Tomcat, que como su nombre indica son las librerias comunes a todos los proyectos.


Ejemplo:
	Uso de métodos dentro de un archivo .jsp 
Para ello creamos un archivo con extensión .jsp
[image: ]
	El archivo debe ir dentro de la carpeta de WebContent, en esta carpeta podemos colocar también archivos .html o .css
[image: ]
El código que nos genera es el siguiente:
[image: ]



El código de nuestra aplicación es:
	<%!
double res=0;
double funcion1(int a, double b){
return a * b; };
%>
<%
// no usar objetos request y out fuera de scriptlet
// porque no estan creados por java todavia
if(request.getParameter("OK") != null){
// llamando o invocando funcion uno y pasando parametros
// recordar que se pueden mandar datos o variables
double alfa=funcion1(2,2.5) + 3 + funcion1(2, 3.3);
res= alfa;
};
// construyendo forma dinamica
out.println("<FORM ACTION=prog14.jsp METHOD=post>");
out.println("RESULTADO:<INPUT TYPE=TEXT NAME=RESULTADO value="+res+"><BR>");
out.println("<INPUT TYPE=SUBMIT NAME=OK VALUE=evento1 ><BR>");
out.println("</FORM>");
%>



Lo ejecutamos
[image: ]
[image: ]
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SESIONES
Tomcat mantiene automáticamente las sesiones de usuario:
· Por defecto, utiliza cookies para que el cliente envíe su identificador de sesión en cada petición.
· Cada sesión se representa con un objeto HttpSession.
· Una sesión caduca tras un tiempo (configurable) sin recibir peticiones correspondientes a la misma.
Obtención del objeto sesión desde el servlet:
HttpServletRequest.getSession(boolean create):
· Devuelve el objeto de sesión correspondiente a la petición.
· Con parámetro true, crea una nueva sesión si la petición no corresponde a ninguna sesión.
Se puede almacenar objetos en la sesión:
· HttpSession.setAttribute(String name, Object value)
· HttpSession.getAttribute(String name)


COOKIES
1.-Crear un objeto cookie a partir de la clase Cookie con
Cookie Galleta = new Cookie(NomCookie, ValCookie);
donde “NomCookie” será el nombre de la cookie y “ValCookie” será el valor asociado a esta cookie.
2.-Vamos a fijar su fecha de caducidad/expiración por medio del método,
Galleta.setMaxAge(1*365*24*60*60); //Expira dentro de un año.
Galleta.setMaxAge(-1); //Expira al finalizar la sesión del cliente/navegador.
3.- Vamos a eliminar una cookie haciendo que su expiración sea cero, con
Galleta.setMaxAge(0); //El cliente/navegador eliminará la cookie en la siguiente llamada.
4.- Vamos a limitar el directorio donde se encuentra la página jsp o servlet que tendrá acceso a las cookies, con
Galleta.setPath(“/”); //Directorio por defecto desde donde se capturarán las cookies.
3.-Vamos a enviar esta cookie al solicitante de la página a través del objeto implícito response con
response.addCookie(Galleta);
5.-Vamos a recuperar todas las posibles cookies almacenadas en el cliente con,
Cookie[] galleta = request.getCookies(); //Recuperar todas las cookies
Cookie[] galleta = request.getCookies(“kuki”); //Recuperar una cookies llamada kuki
ARCHIVO WAR
Normalmente cuando se trabaja sobre un proyecto web J2EE se hace sobre una herramienta de desarrollo como eclipse y para probar la aplicación la herramienta suele hacer un despliegue automático para poder hacer pruebas de forma rápida.
Cuando tenemos la aplicación terminada el despliegue se hará sobre un servidor de producción. Este servidor es el que usarán los usuarios de la aplicación Web. Este despliegue normalmente se realiza utilizando un archivo WAR.


Despliegue automático en Eclipse IDE for Java EE Developers
Se publica nuestra aplicación en Tomcat. Paso conocido como Despliegue (Deployment)
Se inicia el servidor Tomcat
Se abre un browser o cliente http interno apuntando a http://localhost:8080/first-jee/login.html
Lo primero que uno creería es que en el paso 1 eclipse publica el contenido de estas carpetas Java Resources y WebContent en el directorio webapps de Tomcat, pero Eclipse publica en un directorio temporal dentro del workspace. En mi caso
C:\eclipseJEE2\workspace\.metadata\.plugins\org.eclipse.wst.server.core\tmp0\wtpwebapps
Un archivo WAR es un archivo comprimido con todos los archivos que hasta ahora desplegamos manualmente en webapps. Este archivo internamente tiene la misma estructura que usamos anteriormente: directorio WEB-INF, lib, classes, etc. Para desplegar un WAR en Tomcat basta con copiarlo al directorio webapps.
Una buena razón para utilizar archivos *.war es que normalmente los equipos de desarrollo de aplicaciones y los de instalación están conformados por distintas personas. Enviar un solo archivo para desplegar es más sencillo y presta a menos confusiones que enviar varios.
Eclipse JEE permite generar el archivo WAR de la aplicación seleccionando el proyecto, click en botón derecho del ratón - Export -WAR file:
[image: http://www.edu4java.com/_img/servlet/export-menu.png]
En Destination colocamos el lugar donde se guardara el archivo WAR. En este caso será en el directorio webapps de la instalación de Tomcat.
[image: http://www.edu4java.com/_img/servlet/export-war.png]
Para probar la aplicación sólo tengo que iniciar Tomcat ejecutando
C:\apache-tomcat-6.0.33\bin\start.bat
y a continuación abrir un browser con
http://localhost:8080/first-jee/login.html
por defecto en el url se pone el nombre de WAR sin la extensión: 
first-jee
Realizado por: Diana Alfaro	Página 1
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